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Welcome 

This training provides employees with the information necessary to use Cardinal.  It is not intended to replace existing 
Commonwealth and/or agency policies. 
  
In this course, we will show you each of the reporting tools available in Cardinal, most of which are applicable to all of the 
functional areas and their modules. 
 
These training materials include diagrams, charts, screenshots, etc., that clarify various Cardinal tasks and processes.  The 
screenshots are taken from Cardinal and show pages that not all users can access.  They are included here so you can see how 
your specific responsibilities relate to the overall transaction or process being discussed. See your agency’s security Handbook, 
located on the Cardinal website, for a list of available roles and descriptions. 
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Course Objectives 

After completing this course, you will be able to: 

• Run reports on an ad hoc basis using different reporting options. 

• Retrieve existing batch generated reports. 

• Add reports to your Favorites folder. 

• Navigate to Query Viewer. 

• Search for a query. 

• Run a query and display the results in a new browser window. 

• Add a query to your Favorites folder. 

• Download query results to multiple file formats. 
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Course Agenda 

Today, we will cover the following topics: 
 
• Lesson 1:  Understanding Cardinal Reporting 

 
• Lesson 2:  Ad Hoc Reports 

 
• Lesson 3:  nVision Reports 

 
• Lesson 4:  Query Viewer  
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Lesson 1: Understanding Cardinal Reporting 

This lesson covers the following topics: 
 

• Cardinal Reporting Resources 
 

• Running and Retrieving Reports 
 

• Retrieving nVision Reports 
 

• Running Cardinal Queries 
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Key Concepts 

Key concepts in Cardinal Reporting include: 
 

• All users can access reports and queries in Cardinal. 
 

• You can run reports on an ad hoc basis or retrieve nVision reports that Cardinal creates nightly during batch 
processing. 
 

• Queries allow you direct access to the database for simple data pulls. 
 

• Cardinal uses various report and query tools:   
• Excel provides you the ability to sort and analyze reported data further.   
• Crystal Reports and Structured Query Reports (SQR) are view only and do not allow any data manipulation. 
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Reports and Queries 

There are three ways to extract data from Cardinal: 

• Reports – can provide high volumes of data and summarize data across one or more functional areas 

• Queries – access the database directly and are best used for defined information requests 

• Inquiries – access information on a Cardinal page or component, where you can view details about a specific item or 
transaction 

 
Report and Query Execution 

Reports, i.e., ad hoc and nVision reports, can be run from:  

• Your Home page using the hyperlinks located in the myCardinal Financials portlet 

• From any Cardinal page: Main Menu >  myCardinal Financials > Financials Report Retrieval > FIN Report 
Manager 

• From any Cardinal page: Main Menu >  Reporting Tools > Report Manager 
 
 Queries can be run from: 

• Your Home page using the hyperlinks located in the myCardinal Financials portlet 

• From any Cardinal page: Main Menu >  Reporting Tools > Query > Query Viewer 
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Main Menu and myCardinal Portlet 

Cardinal’s Home page provides quick access to: 

• Favorites – You can access and manage ad hoc reports and Cardinal pages that you previously saved using the Add 
to Favorites hyperlink which is located on every Cardinal page in the Navigation Header. 

• Main Menu – The drop-down Main Menu provides access to all the functional area and module reports, and is 
accessible from all pages in Cardinal. 

• myCardinal Financials portlet – Provides access to: 

• Financials Report Execution, which includes module specific, most frequently run ad hoc reports, and queries. 

• Financials Report Retrieval is used for accessing nVision reports via the FIN Report Manager, or all user run 
reports using FIN Process Monitor where you can also check your report’s status. 

 
Your Cardinal security determines which pages you can access in Cardinal. 
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Lesson 1: Summary 

In this lesson, you learned that: 
 

• There are three basic ways to extract data from Cardinal: reports, queries, and inquiries. 

• All users can access Cardinal reports and queries. 

• Cardinal uses various reporting tools to create reports and queries: SQR, Crystal Reports, nVision, and Cardinal 
Query. 

• You can access commonly used ad hoc reports, Query Viewer and nVision reports from the Home page using the 
myCardinal Financials portlet. 

• You can access all functional area and module specific ad hoc reports using the Main Menu.  For a comprehensive 
list of reports for your specific module or functional area, navigate to each module’s folder using the Main Menu. 
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Lesson 2: Ad Hoc Reports 

This lesson covers the following topics: 
 

• Running ad hoc reports from the Main Menu 
 

• Creating a Run Control ID to submit a report request 
 

• Tracking the Status of your report 
 

• Opening the report 
 

• Downloading the report and sharing it with others 
 

• Running reports from the myCardinal Financials portlet 
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Ad Hoc Reports 

Ad hoc reports are run in real time. You can access ad hoc 
reports from your Home page using the hyperlinks located 
in the myCardinal Financials portlet. 
 
You can also access all ad hoc reports from the Main 
Menu.   
 
For example, to run the Cardinal Trial Balance Report, 
which is located in the General Ledger folder: 
 

• Navigate using the following path: 
  
 Main Menu > General Ledger > General Reports > 

Cardinal Trial Balance Report 
 

There are two trial balance reports.  The one titled 
Cardinal Trail Balance Report is a customized Cardinal 
report. 
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Run Control ID 

First search for an existing Run Control ID using the Find 
an Existing Value tab.  If a Run Control ID has not been 
created, you can create one using the Add a New Value tab. 
 

In creating and naming a Run Control ID consider the 
following: 

• Up to 30 characters are allowed 

• No blank spaces 

• Do not use the wildcard symbol (%) 

• Underscore can be used, e.g., Cardinal_Trial_Balance 
 

• Once you create a Run Control ID you cannot delete it. 
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• Give your report a Run Control ID that is relevant and descriptive in order to help you remember it for future use.  
 
Once you have named your new Run Control ID, click Add. 

To run an ad hoc report you must have a Run Control ID. A Run Control ID is the name you give your saved report 
parameters.  



Re-Use Existing Run Controls 

Once you create the Run Control ID, it is saved for future use along with the parameters you specified.  To find an existing 
Run Control ID select the Find an Existing Value tab and click search.  All Run Control IDs will be returned.  Or, if you 
know the name of the Run Control ID you may limit your search results by entering the name, or the first few characters, 
and click Search. If you know only part of the Run Control ID you can use the wildcard, e.g. %, in your search. 
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Report Request Parameters 

Report Request Parameters, also referred to as criteria, are used to filter the data returned in your report.  Some 
parameter fields have magnifying glasses, i.e., look up icons, or drop-down menus to help you select from a list of available 
values. 
  

Parameters available vary by report.  In the example below, the parameters for the Cardinal Trial Balance report include: 
Business Unit (BU), Fiscal Year, Accounting Period, ChartField Selection, Ledger Selection and Account Details.  
As a general rule, Ledger Selection should always be Actuals.   
 
After choosing your parameters, click Save to save the Run Control ID along with the selected parameters for future use.  
If you wish to run the report, as well as save, click the Run button. The Process Scheduler Request page will be 
displayed.  
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Report Request Parameters (continued) 
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Process Scheduler Request 

The Process Scheduler Request page generates a request to process the report using the parameters you identified in 
your Run Control ID. 
  
Most information on the Process Scheduler Request page is automatically filled in by Cardinal. On some reports you can 
change the report Type and Format. Not all types or formats work for all reports. You can also choose to email the report to 
yourself and/or others by changing the Type to Email and completing the Distribution information. Click the OK button to 
create the process request, i.e., kick off the report. 
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Process Monitor and Instance Number 

After you have kicked off  your report, Cardinal takes you back to the report page where you set up your Run Control ID 
and defined your parameters. 
  
Under the Run button you see a Process Instance number that is unique to the report request you just kicked off.  Use 
this number to help you find your report request on the next page. 
  
Click the Process Monitor hyperlink to access the Process Monitor page where you can see the status of your report 
request and access your report once the request is complete. 
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Process Monitor and Instance Number (continued) 
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Report Execution Status 

The Process Monitor displays a Process List as seen below. Here you can check the status of your report.   
 
To find your report: 

• Under the View Process Request For section use the two fields to the right of the Last field, enter the days (or 
hours, etc.) to display only the reports run during that period, e.g., reports run during the last 10 days. The Last field 
can also be modified by selecting the drop-down arrow. 

• Under the Process List section the Run Date/Time column defaults to list the reports in chronological order with the 
most recently run reports listed first. 

As Cardinal processes report requests, the Run Status and Distribution Status update. To update the Process List page 
contents, including status, click the Refresh button. 
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Run and Distribution Status Updates 

Run Status:  

• Queued - Request has not yet started.  

• Processing - Request is in progress. 

• Success - Report is complete. 
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 Distribution Status: 

• N/A – Report request is queued, waiting to be 
executed. 

• Not Posted - Report execution has completed, report 
not yet posted. 

• Posting - Report is being posted. 

• Posted - Report is posted to the report repository and 
is available for viewing. 

Click the Refresh button until the Run Status is Success and the Distribution Status is Posted.  At that point the report is 
ready to retrieve.  Click the Details hyperlink to go to the Process Detail page to retrieve the report. 



Process Detail 

 From the Process Detail page you can: 

• Select an Update Process option:  Some options 
listed may be grayed out, i.e., not available, based 
on the status of your report. 

• Click the View Log/Trace hyperlink to access your 
report. 

Click on the View Log/Trace hyperlink. 
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View Log / Trace – File List 

The View Log/Trace page identifies your report by Report ID, Name, and Process Instance.  The File List section lists the 
files associated with your report request: 

• The .log file provides details about the processing. 

• The .PDF file is your report. When you click on the hyperlink the report will open in a new internet browser window. 

• The .out file shows the run control parameters entered, the start and end date, and the duration of the process. 
 

Click on the PDF hyperlink to open your report in a new internet browser window. 
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Download and Share Report 
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There are two ways to save your report to your computer: 

• From the View/Log Trace page under the File List section of the page, right click on the file name / hyperlink. Click 
Save target as… to save to your computer. Follow the prompts. 

• Click on the report name / hyperlink to open the report.  Using the internet drop-down menu bar choose File > Save 
As and save the report file to your computer. Follow the prompts. 
 

Once you have downloaded the report you can forward it to others. 



View Report Output 
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myCardinal Financials Portlet 

You can also use the myCardinal Financials portlet located on your Home page to access reports and queries.   

• Financials Report Execution:   

• Functional area folders, e.g., AP Reports, AR reports, contain lists of the most commonly run reports for that 
functional area. Clicking on a functional area folder hyperlink will open a page with a list of the most commonly run 
reports for that functional area. 

• The Financials Query-based Reports  hyperlink brings you to the Query Viewer, discussed in Lesson 4. 

• Financials Report Retrieval: 

• The FIN Report Manager displays reports you ran and nVision reports run by Cardinal, discussed in Lesson 3. 

• The FIN Process Monitor displays the status, and access to, reports that you have run.  
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myCardinal Financials Portlet (continued) 

To run a report from the myCardinal Financials portlet click on the Financials Report Execution hyperlink.  You can also 
access the Financials Report Execution page from any Cardinal page using the Main Menu drop-down:   
 
Main Menu > myCardinal Financials > Financials Report Execution.  
 
The Financials Report Execution page provides hyperlinks to reports grouped by functional area, e.g., AP Reports, AR 
Reports. Click on a functional area hyperlink, or choose x More… to view the frequently run reports for that functional area. 
Click on a specific report hyperlink to run the report. 
 
 
 
 
 
 
 
 
Not all reports are accessible through this page.  All functional area reports are available using each module’s navigation 
path from the Main Menu.  For example, Accounts Payable ad hoc reports are available using the following path: 
 
Main Menu > Accounts Payable > Reports 
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Hands On Practice – Run an Ad Hoc Report 

This practice will reinforce the concepts learned in the lesson.  Your instructor will provide direction regarding the activity.  
Please ask your instructor if you have any questions.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
For additional hands on practice, run the Ad Hoc Report simulation on the Cardinal website:   
 
Go to www.cardinalproject.virignia.gov, click on the Statewide Toolbox  > Training Materials, scroll down to Navigation, 
Reporting, and Approvals.  Under Simulations, click on Introduction to Reporting in Cardinal and select Run an Ad 
Hoc Report.  
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Lesson 2: Checkpoint 

Now is your opportunity to check your understanding of the course material. 
 
Answer the review questions below: 
 

1. You should always search for an existing Run Control ID before creating a new one because Run Control IDs cannot be 
deleted. (TRUE or FALSE) 

2. Before you can access the report, the Run Status must update from Queued to Success and the Distribution Status must 
update from N/A to  ________. 
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Lesson 2: Summary 

In this lesson, you learned:  
 

• Before you can run a report, you must find an existing Run Control ID or create a Run Control ID. 

• Once you create a Run Control ID you cannot delete it. 

• You can use the Process Scheduler Request page to enter and update information about how the report is run, including 
timing and output format. 

• You can check the status of your report on the Process Monitor page. 

• You can save frequently run ad hoc report pages to Favorites. 
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Lesson 3: nVision Reports 

This lesson covers the following topics: 

• Using FIN Report Manager 

• nVision report retrieval 

• nVision drilldowns 
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nVision Reports 

nVision is a reporting tool that generates reports each night in batch. All users can access nVision reports. You can access 
these reports any time after the batch completes.  
 
nVision Reports: 

• Approp Bud Actual (VRGL003A): Budget to Actual – Program, Fund 

This nVision report provides appropriations and expenditures for a Business Unit by Fund and Program for all Programs 
within the Fund specified in the report scope. 

• Oprl Bud Actual (VRGL004A): Budget to Actual – Fund, Program, Account 

This report compares the agency operational budget to the expenses incurred per period by Fund, Program, and 
Account. 

This nVision report provides operational budget and actual expenditures for a specified Business Unit and related Fund 
and Program, summarized by Account for accounting period and fiscal year to date (FYD). 

• Proj Fin Summary (VPAR0567): Project Financial Summary Report 

This nVision report is run for all projects related to a specified Business Unit by summary project and provides the project 
budget for both the summary project and the operating projects. It also provides the expenditure actuals for year to date 
(YTD) and project life to date (LTD). In addition, the project to date over / under project budget also displays the variance 
between project budget and project LTD spending amount.  The percent of project budget remaining is displayed at the 
end, which tells the remaining budget for that Project. 
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nVision Reports (continued) 

 
nVision reports (continued): 

• CSC Exp Account (VRGL0614): Budget to Actual – Cost Center by Account  

This nVision report provides operational budget and actual expenditure amounts for a Business Unit by Account and 
Cost Center for the current period and year to date. 

• Dept Exp Account (VRGL0615): Budget to Actual – Department by Account 

This nVision report provides operational budget and actual expenditure amounts for a Business Unit by Account and 
Department for the current period and year to date. 

• Proj Exp Account (VPAR106B): Project Expenditures by Account  

This report breaks out total posted amounts by Account under a Project  and Business Unit (BU) from the Project 
Budget Ledger, Journal Header, and Journal Lines tables for project life to date and year to date time spans. 

• Proj Exp Task (VPAR106C): Project Expenditures by Task 

This nVision report breaks out the total posted amounts by all Tasks under a Project and Business Unit from the Project 
Budget Ledger, Journal Header and Journal Line tables for project LTD and YTD. 
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nVision Reports (continued) 
 

nVision reports use Excel version 2007 or higher.  If you have an earlier version of Excel installed on your computer, you must 
install version 2007 or higher in order to open an nVision report.  Without Excel 2007 or higher the report contents will not 
display in a readable format. 
 

To select and open an nVision report, from your Home page, click on the FIN Report Manager hyperlink in the myCardinal 
Financials portlet.  
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nVision Reports (continued) 
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When you click on FIN Report Manager, you may get the following Message: 
 
 

Select Cancel in order to avoid a long delay. Once you have canceled the FIN Report Manager page will open and you can 
enter report search parameters to filter your results and avoid the long delay.  



 
nVision Reports (continued) 
 

The FIN Report Manager contains four tabs which:  

• List reports you have run 

• Sort reports under tabs for easy identification and access 

• List reports run in batch overnight using nVision 
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nVision Tabs 

FIN Report Manager tabs: 

• List: The List tab allows you to enter your report parameters such as the Folder, Instance range, and Name for the 
nVision report you want to retrieve.  

• Explorer: The Explorer tab displays a hierarchical view of the folders and reports by BU and fiscal year.  Navigation 
tools allow you to scroll through the pages from First to Previous to Next to Last to Left to Right. 

• Administration: The Administration tab displays nVision and ad hoc reports that you have run.  You can click on the 
Details hyperlink to access the ad hoc reports.  This is the only tab that displays new reports, e.g. Drilldown reports, 
that have been scheduled or are in the process of being posted to the report repository. 

• Archives: The Archives tab lists historical records of user run ad hoc reports which were run more than 30 days ago 
and batch reports run more than 90 days ago. 
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Retrieving nVision Reports – List Tab 

Filtering Reports Viewed: 
 
On the List tab, in the View Reports For section, you enter your search criteria: 

• Select the specific Folder drop-down menu that will contain the report you wish to retrieve, e.g., APPROP BUD 
ACTUAL. 

• Enter a value in the Name field.  If you are retrieving the Budget to Actual – Fund, Program report for your agency, you 
can enter your agency’s Business Unit number prefixed with BU, e.g., BU12900, or your Business Unit number and 
a specific Fund in this field. The wildcard (%) may also be used, e.g., BU12900%01000%.  

• The Name field is case-sensitive, e.g., the Business Unit abbreviation of BU must be capitalized. 

• Although not a required field, specifying a value in the Name field narrows the search results. 

• Use the Last or Date Range field to identify the time span that you want to view.  Using Last specifies a time span for 
the most recent reports run.  Using From and to dates lists only reports that were created during that date range. 

• Once you have entered your search criteria, click Refresh to update the Reports section. 

• Click on the hyperlink for the Report you want to view.  Be sure to verify that you are selecting the latest version of the 
report based on the value in the Completion Date/Time column. 
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Retrieving nVision Reports – List Tab (continued) 

The two drop-down boxes next to the Last field allow the time to be specified in minutes, hours, days, or years. The report 
retrieval criteria in this example uses the Last 30 Days.  
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Retrieving nVision Reports – List Tab (continued) 

The report retrieval criteria in this example uses Date Range.  The dates that are selected for the Date Range relate to the 
report execution date. To obtain the most recent reports, the to date specified should be the current date. Click on the 
Report hyperlink for the report you wish to view. 
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Retrieving nVision Reports – List Tab (continued) 

After you click on the Report hyperlink, you may get this warning message: 
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Click OK.  The selected report will open in Excel. 



Retrieving nVision Reports – Explorer Tab 

The Explorer tab displays a hierarchical view of the folders, 
reports by Business Unit, and then fiscal year (FY).   

• Find the specific report folder with the report you wish 
to view, e.g., APPROP BUD ACTUAL.   

• Click the plus (+) icon to expand / open the folder. 

In this example, Business Units, for the report folder 
previously selected, have subfolders in which their related 
reports are stored. 

• Find your agency’s folder, e.g., BU12900 and click the 
plus (+) icon to expand / open the folder. 

• Find the FY you wish to view and click the plus (+) icon 
to expand / open the folder. 

• Search for the report you wish to open and click on the 
report hyperlink to open the Report page.  
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Retrieving nVision Reports– Explorer Tab (continued) 

The Report page displays with information about the report you selected.  nVision reports always have the .xls extension on the 
file name which indicates it is an Excel file. 
 
In the File List section, click on the report Name hyperlink to open the report in Excel.   
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Retrieving nVision Reports– Explorer Tab (continued) 

A pop-up message will be displayed.  To open the report click on Open.  If you wish to save the file before opening it, click Save 
or Save as.  
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• Excel displays a warning message.  Click Yes to continue.  This pop-up message occurs each time you try to open an Excel 
report in Cardinal.  Sometimes the message is hidden behind another screen and gives the illusion that the report is still 
downloading. If you do not see the pop-up message, click the Alt+Tab keys until you see it, or click on the Excel icon on the 
toolbar at the bottom of your screen. Click Yes to open the report. 
 



Retrieving nVision Reports (continued) 

nVision reports are in an Excel format which allows users to use all the powerful features of Excel to help further analyze 
the data. 
 
Click the + icon, or the 123 boxes, to expand / unhide additional rows or columns of data. Click the – icon, or  the 123 
boxes, to collapse / hide the additional rows and columns of data. 
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See the next slide for an expanded view of all rows and columns. 



Retrieving nVision Reports (continued) 

When you click the + icon, or the 123 boxes, additional rows and columns of data display.  The nVision term for this is nPlosion.  
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Drilldown 

The nVision Drilldown feature is useful when you need to know what detailed transactions are included in an amount on 
your report.  In order to drill down within an nVision report, you must have the DrillToPIA Add-In for nVision configured 
within Excel and you must be logged into Cardinal. The Add-Ins tab is in the Excel menu ribbon which is located at the top 
of your screen. 
 
Drilldown does not work on a cell with a formula, e.g., a total field, nor on a cell in the Appropriations column.   
 
To use the Drilldown feature, select a cell.  Click on the Add-Ins menu drop-down.  The nVisionDrill menu opens.  Click 
Drill.  Cardinal will open and display the Run Drill Down page.  
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Drilldown (continued) 

. 
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Drilldown (continued) 

The Run Drilldown page displays the Available 
Drilldown Layouts. 
 
You can Drilldown by ChartFields such as Account, 
Department, and Task, as well as by Journal and 
Voucher. 
 
Available Drilldown Layouts where the name begins 
with “Drilldown by XXX” are customized Cardinal 
layouts and are the ones used most often. 
 
Click on the Run Drilldown button to the right of  the 
drilldown layout description to kick off the report.   
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Drilldown (continued) 

A maximum of 65,532 rows can be returned by the drilldown for the selected cell.   
 
The following disclaimer message may display regarding the number of rows potentially being returned.  This Excel 
message screen may be hiding beneath another screen.  If you do not see it, click the Alt+Tab keys until you see it, or click 
on the Excel icon on the toolbar at the bottom of your screen.  Click OK to continue. 
 
 
 Click OK to continue.  If you experience performance issues with a drilldown, consider modifying the scope of the drilldown. 
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Drilldown (continued) 

After kicking off an nVision Drilldown report, Cardinal opens the Administration tab on the FIN Report Manager page. 
Drilldown reports will have a Description, i.e., file name, that is prefixed with DR and is appended with .xls. The 
Description field is the hyperlink to the actual Excel Drilldown report.   
 
If you do not see your report, click Refresh until your report displays at the top of the Report List section of the page.   
 
To open your drilldown, click on the report hyperlink in the Description column. 
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Drilldown (continued) 

Just like when opening the original nVision Excel report, a pop-up message may appear stating results may exceed 1,000 lines.  
Remember the pop-up message may be hidden and you may have to click the Alt+Tab keys until you see it, or click on the 
Excel icon on the toolbar at the bottom of your screen.  Once the message appears, click OK to continue.   
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The requested Drilldown report will open in Excel.  You can initiate more Drilldown reports from the Drilldown report if 
desired. 



Drilldown (continued) 
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Hands On Practice – Retrieving nVision Reports 

This practice will reinforce the concepts learned in the lesson.  Your instructor will provide direction regarding the activity.  
Please ask your instructor if you have any questions.  
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Lesson 3: Checkpoint 

Now is your opportunity to check your understanding of the course material.  
 
Answer the review questions below: 
 

1. Drilldown reports are displayed on the Administration tab on the FIN Report Manager page. (TRUE or FALSE) 

2. You must have Excel 2007 or higher to view nVision reports. (TRUE or FALSE) 
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Lesson 3: Summary 

In this lesson, you learned: 
 

• Before you retrieve an nVision report you must have Excel 2007 installed on your computer. 

• nVision reports are generated nightly in batch. 

• The FIN Report Manager page lists nVision reports in these tabs: List, Explorer, and Administration. 

• Use the List or Explorer tabs to retrieve your nVision reports. 

• You can drill down on cells that contain expenditure amounts. The Drilldown feature does not work on a cell with a 
formula or a cell in the Appropriations column.   

• nVision reports, including drilldowns, open in Excel.   
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Lesson 4: Query Viewer 

This lesson covers the following topics: 

• Query Viewer navigation 

• Query searches 

• Running a query and displaying the results in a new internet browser window 

• Adding a query to your Favorites 

• Downloading query results to different file formats, e.g., Excel, CSV 
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Query Viewer 

Query Viewer allows you to search for and view a query in Cardinal. 
  
Using Query Viewer you can: 

• Search for a query 

• Preview a query 

• Run a query and display results in a new internet browser window 

• Download the query results to Excel or CSV 

• Print a query 
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You can access the Query Viewer from the myCardinal Financials portlet on the Home page. Click on the Financials 
Query-based Reports hyperlink in the myCardinal Financials portlet to open the Query Viewer. 
 
 
 
 
 
 
 
 
 
 
 
You can also access the Query Viewer from any Cardinal page by navigating to either of  these paths: 

• Main Menu > Reporting Tools > Query > Query Viewer  

• Main Menu > myCardinal Financials > Financial Report Execution > Financials Query-based Reports 
 

Query Viewer Navigation 
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Query Viewer Navigation 

On the Query Viewer page, you have the option to do a Basic Search or Advanced Search to find the query you need. 
The Basic Search defaults when the page is first displayed. You can click on the Advanced Search hyperlink to see more 
robust search options. 
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Basic and Advanced Search 

Query Viewer: 
Using the Basic Search, you can: 

• Select a field to search against using the Search By 
drop-down list.  Available search fields include 
Description, Folder Name, Owner, and Query 
Name.   

• Use the Basic Search condition which is limited to 
“begins with”. 

Using Advanced Search, you can:  

• Select search operators such as contains, >, <, =, 
and not =. 

You may use the wildcard (%) with both the Basic Search 
and Advanced Search options.   

Click the Favorite hyperlink to the right of a query result to 
add the query to your My Favorite Queries section of the 
Query Viewer page. 

Personalize your column and sort order by clicking on the 
Customize link. 
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Basic and Advanced Search (continued) 
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Query Output 

On the Query Viewer page, find the query you wish to run.  Click the HTML or Excel hyperlink to open the query in a new 
internet browser window.  Some query results display immediately, but most require that you enter parameters.  Query 
parameters filter the data so you view only the data you want. 
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Query Output (continued) 

Enter the required parameters and click the View Results button. If you selected to run the report to Excel on the previous 
screen, after you enter the required parameters and click View Results, you will get a pop-up message asking what you want 
to do with the file, Open, Save or Save as.  If you selected to run the report to HTML, your results will appear on the same 
screen below the parameters. 
  
When you run a query to HTML, the results page includes hyperlinks to download the results to an Excel Spreadsheet or 
CSV Text File.  When you click the hyperlink for either option you will get a pop-up message asking you what you want to do 
with the file, Open, Save or Save as.  
 
In order to use Excel features, such as pivot tables and filtering, the report data must be opened in Excel.  
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Hands On Practice – Run a Query 

This practice will reinforce the concepts learned in the lesson.  Your instructor will provide direction regarding the activity.  
Please ask your instructor if you have any questions.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
For additional hands on practice, run the Query simulation on the Cardinal website:   
Go to www.cardinalproject.virignia.gov, click on the Statewide Toolbox > Training Materials, scroll down to Navigation, 
Reporting, and Approvals.   Under Simulations click on Introduction to Reporting in Cardinal and select Run a Query. 
 

64 

http://www.cardinalproject.virignia.gov/


Lesson 4: Checkpoint 

Now is your opportunity to check your understanding of the course material. 
 
Answer the review questions below: 
 
1. In Query Viewer, you can: 

a) Search for a query 
b) Run a query to HTML or Excel 
c) Download a query to Excel or CSV 
d) All of the above 
 

2. Which of the following is a simple search used to find a query in Query Viewer. This type of search uses only one 
search field. 

a) Basic Search 
b) Advanced Search 
c) Field Search 
d) Enhanced Search 
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Lesson 4: Summary 

In this lesson, you learned: 
 

• How to navigate to Query Viewer 
 

• How to search for a query 
 

• How to run a query and display the results in a new internet browser window 
 

• How to add a query to your My Favorites Queries section in Query Viewer 
 

• How to download query results 
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Course Summary 

In this course, you learned how to: 

• Run reports on an ad hoc basis using different reporting options 

• Retrieve existing batch generated reports 

• Add ad hoc report pages to your Favorites folder 

• Navigate to Query Viewer 

• Search for a query 

• Run a query and display the results in a new internet browser window 

• Add a query to your My Favorites Queries section in Query Viewer 

• Download query results to multiple file formats 
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Course Evaluation 

Congratulations!  You successfully completed the SW NAV220: Introduction to Reporting in Cardinal course.  Please use 
the evaluation link to assess this course. 
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Appendix 

• Key Terms 
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Key Terms 

Add To Favorites:  The Add To Favorites hyperlink is on the menu bar at the top right of every page in Cardinal. It allows you 
to set up your own list of favorite ad hoc report pages and Cardinal pages. You can then access them from any page in Cardinal 
using the drop-down menu titled Favorites, which is located in the menu bar at the top left of every page in Cardinal. 

DrillToPIA Add-in:  DrillToPIA Add-In is the tool that allows you to run drilldowns in nVision.  This tool is installed by your 
agency’s IT staff.  For installation instructions, see the DrillToPIA Add-In for nVision Drilldown job aid located on the Cardinal 
Project website.  

Favorites:  The Favorites hyperlink in Query Viewer allows you to set up your own list of favorite queries for quick access.  
After searching for a query in Query Viewer, click on the Favorite hyperlink located to the right of the selected query you wish to 
save as a favorite.   

FIN Process Monitor:  The FIN Process Monitor allows you to monitor the status of your report, as well as a link to access 
your report. 

FIN Report Manager:  The FIN Report Manager provides you with a list of reports and process output.  Reports include reports 
a user has run, i.e., ad hoc and drill down reports, plus nVision reports run by Cardinal. 

myCardinal Financials portlet:  The myCardinal Financials portlet tool is used to retrieve reports.  This portlet provides a 
quick link from the Home page to many reports. The portlet provides hyperlinks to Financial Report Execution for frequently 
used AP, AR, GL reports, Financials Query-based Reports, FIN Report Manager, and the FIN Process Monitor. 

Parameters:  Parameters are values, i.e., criteria, used to specify the data used in a report.  The parameters available vary 
depending on the selected report. 
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Key Terms (continued) 

Process Instance:  The Process Instance is a number which identifies each report processed.  Cardinal assigns this value 
incrementally to each report that is run. 

Process Scheduler Request:  The Process Scheduler Request page identifies the server and output type for the report, such 
as SQR or a Crystal Report, for a report request. The Process Scheduler  Request page also allows a user to schedule a 
report request to run at a selected time in the future, or on a recurring basis. 

Report Repository:  The Report Repository is a location where reports that have been run are saved, including nVision and 
other reports run in batch, ad hoc reports and nVision Drilldown reports run by a user.  The user does not have direct access to 
the repository.  Instead, the user can view a filtered list of reports through the FIN Report Manager page, based on User ID and 
security access.   

Query:  A Query is a request for information from a database.  Users generally enter parameters into Cardinal to extract and 
view data. 

Query Viewer:  The Query Viewer is a Cardinal page used to search for and view a query. 

Query-based Reports:   Query-based Reports are queries provided by Cardinal, run using Query Viewer.  Users enter 
parameters to narrow the returned data results but cannot customize a query. 

Run Control:   A Run Control is a database record that provides parameter values for a particular process, e.g., report. 

Run Control ID:  A Run Control ID is an identifier that, when paired with your User ID, uniquely identifies the process (report) 
you are running.   
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